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Training Outline

Purpose of Report

User Roles

System Improvements
Logging On and Registration

Data Entry
— Solid Waste Management
— Printing and Finalizing Data

Welcome to the Sustainable Practices training.

You are welcome to leave the training after your relevant section has been discussed.

However, the Bureau and Office Central Office and HQ users should listen to the entire
presentation

The B/O Central Office user session will follow this one
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The GoToWebmar Attendee View
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Before we get started, | want to review a few housekeeping items and let you know how
you can participate in today’s Web event.

We’re looking at an example of the GoToWebinar Attendee Interface which is made up of
two parts. The Viewer Window on the left, which allows you to see everything the Presenter
will share on their screen, and the Control Panel at the right. Within that Control Panel is
how you can participate in today’s event, so let’s look at that.

(Transition to Next Slide)



How to Participate Today

Fie View Help

) Aud  Full Screen
(=] e i B =
udio
@ v Auto-Hide the Control Panel rs @
Hide Control Panel

@

* Open and close your Panel

{) Default Control Pangl Layout
swre-diready on the cal, press #72% now « View, Select, and Test your audio
© Guestions 5 »  We will not be using the “raise your
= | hand” feature

[Enter a question for staff]

Q&A addressed at the end of each
section of the presentation

sl

Start Holding your Own Web Events with
GoToWebinar
Webinar ID: 977-124-241

GoToVWebinar™

Move mouse over the Grab Tab

Clicks 1,2, and 3
By clicking the orange arrow, you can open and close your control Panel

Click 4
From the View Menu you can also set the Control Panel not to auto-hide when inactive if you prefer to keep it always open.

Click 5

The Audio pane provides audio information. (If the organizer has given attendees a choice) By default you have joined the Webinar via
Mic & Speakers.

Click 6
Click Audio Setup to select your computer speaker or headset devices.

Clicks 4,5 and 6

If you prefer, you can join the audio via telephone by selecting Use Telephone, and the dial-in information will be displayed, including an
Audio PIN. If you would like to ask any questions of today’s presenters over the phone, you must enter your Audio PIN in order to have
your line unmuted.

Click 7

During (at the end, etc.) the presentation, you have the ability to send questions to our Webinar staff through the Questions pane. Simply
type in your question and click send. (Optional) At the end of the presentation we will do a Q&A session to answer as many questions as
we have time for.

Click 8

During the presentation we may ask you to answer a question by raising your hand. This option is located on the Grab Tab. (Optional)
You can also indicate that you have a question and would like your line unmuted by raising your hand.

Click 9 and 10

We will address Q&A at the end of today’s session, and as a final reminder, today’s Webinar is being recorded, and everyone will receive
an email within 24 hours with a link to view a recording of today’s event.



Training Norms

*All of the phone lines are muted.

*Please submit questions through the
“Questions” area.

*We will respond to questions at the end of
each training section.

*You may leave the training after the sections
relevant to your work have been discussed.

-However, the Bureau and Office Central and HQ users should listen to the entire
presentation.

-The Bureau and Office Central Office users training session will follow this one.



PURPOSE OF REPORT




Purpose of the Report

» Data are needed for a mandated report to the Office of
Management and Budget and the Council on
Environmental Quality

— Annual update for the DOI Strategic Sustainability Performance
Plan

— Annual DOI Greenhouse Gas Inventory

* Questions address:

— Executive Order 13693 — Planning for Federal

Sustainability in the Next Decade
+ Section 3 (j) advance waste prevention and pollution prevention

— Resource Conservation and Recovery Act
— Pollution Prevention Act of 1990




The Process

How is your data used?

Bureau-wide
Report

The data input from Field Users are compiled in the Bureau-wide Report. The Bureau and

Office Reports are then used to develop the updated Department’s Strategic Sustainability
Performance Plan (SSPP) and the Greenhouse Gas Inventory. The SSPP is submitted to the
Office of Management and Budget (OMB) and the Council on Environmental Quality (CEQ).

If you are not familiar with them, but OMB and CEQ are part of the Executive Office of the
President.




Sustainable Practices Database
» The Sustainable Practices Database is
located at http://www.nbc.gov/spreport/

» Field User questions are a subset of the
OMB data call

* 18 questions

» Data entry should take 1 hour or less if
data is readily available

10

System only includes those questions for which data depend on field
responses

10



USER ROLES

11
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User Roles

Bureau
(@]

Program
Managers

DOI

Program
Managers

12

Here you can see the different layers of users.

12



More on Roles

“Central Office” - second-line program
contacts in your region, area, or state office.

At each level, there is a “solid waste
manager.”

Central and HQ roles perform data quality
review of field data.

Managers track report status for individual
facilities.




Data Quality Assurance

Facility User enters data I

Facility User finalizes data and forwards it for review

14
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Status Report for Solid Waste Management

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Status Reports

Facility
os

HQ

District Office
OEPC Albuquerque Regional Office

OEPC Anchorage Regional Office

Started

4of12
(33 %)

4012
(33 %)

Email

Email
Email

Email

OEPC Atlanta Regional Office

Email

'OEPC Boston Regional Office
OEPC Denver Regional Office
OEPC Headquarters

OEPC Oakland

Email

Email

Email

Email

OEPC Philadelphia

Email

OEPC Portland
Other

Program Office

Email

Email

Email

*Sample

data only in

this

presentation,

not actual
data

15

In the “Reports” tab, Central Office users may track the progress of individual facilities.
Select “Status Report for Solid Waste Prevention & Recycling” from the list of options. The
first column shows the name of the facility. The second column shows whether the facility
has started entering data. The third column shows whether a draft of the data is complete.
The fourth column shows whether that draft has been approved by the Central Office. The
fifth column shows whether HQ has approved the data. If a facility has started its data
entry but it is not complete, the Central Office may email the contacts for that facility to

inquire as to the progress of the facility’s data entry.

**Please Note that all of the data shown in this training are just for demonstration

purposes and are not actual data reported by facilities **

Questions?

15



SYSTEM IMPROVEMENT

» New reports for previous years’ data

16
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o Recycling Data

. 2015

- 2013

- 2012
. 2014

o Solid Waste Prevention

- 201
o Solid Waste Prevention Narrative Details

. 2015

. 201
. 2013
- 2012
- 201

o Chemicals Management Data

. 2015

- 2013
. 2012

. 2014

o Download Solid Waste Data in EXCEL

. 2013
- 2012

- 201

New Reports for Previous Years’

Data

17
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LOGGING ON

* Logging Into the System

+ Forgot Username or Password
« System Registration

+ Change Password

* Help Resources

18
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Logging Into the System

ENT OF
-0‘“ Y

-

s> SUSTAINABLE PRACTICES DATABASE

Home ContactUs Help Login

LOGIN

Ifyou are first time user, please click here to register

Ifyou forgot your user name and/or password, please click here to have this information mailed to you I

To unlock your account, please click here. Request a new password and it will unlock your account too.

Please enter your Usemame and Password below and click the ‘Login' bution.

Usemame:
Password:

LOGIN
\umm TO USERS OF THIS SYSTEM: This is a United States anuemmenttnmpuleu aysiem mamtamed by the Department of the Interior, to provide Official
us. only. Use of this system by any consent to monitoring, retrieval, and
by L use may subject violators to cummal tml and for msmplmaw action

19

To Login and register for the site, go to http://www.nbc.gov/spreport/ and then click on the
“Login” tab to see this screen.

Click “register here” if you are a new user.

Click “forgot your username/password” if you’ve forgotten your password or if you’ve been
locked out of the system.

If you’ve been locked out of the system due to unsuccessful attempts to login, click on “to
unlock your account”

Only request a password once, it takes up to 5 minutes for you to receive the new
password. Once you receive your new password, copy and paste it directly from the email
into the login page. Be sure to include any punctuation included in the password.

19



Forgot Username or Password

SUSTAINABLE PRACTICES DATABASE

Home ContactUs Help Login

Forgot Username / Password

Please enter your complete email address and indicate the type of assistance you are requesting, then click the “Submif button. An email will be sent with the

requested information.
Email Address: [—

€ Please confirm my Usemame
€ Please reset my Password
o Please confirm my Usemame and reset my Password.

SUBMIT

The password will be sent to you within 5 minutes. If you request a new password, please be sure that you enter it exactly as it appears in the email that you receive.
‘You may want to Iry copying and pasting the password from the email into the login page, including any punctuation that is included in the password. After you
successtully log in, you are encouraged 1o change your password to something you will remember by going to the "Admin” tab and selecting "Update Password

\'INI!GTO USEIGOF THIS SYSTEM: This is a United States Government cumnuter svs(em rnamtamed by the Depariment of the Interior, to provide Official
only. Use of this system by any consentto retrieval, and
! use may subject violators to cnmma\ cm! and lordlsmnllnarv action.

Notices | Disclaimer | Privacy | FOLA | USA gov| DOl Home | PMB Home

U.5. Dapartment of the Interior
Office of Policy Management and Budget
Last updated: October 22, 2012
This site has baen optimized for Intemet Explorer7 20

This screen appears if you clicked on “Forgot Username/Password” from the Login screen.
Follow the instructions to request information and log in.



System Registration

SUSTAINABLE PRACTICES D

Home ContactUs Help Login

REGISTRATION

Please input your email address to begin registration.

Email Address: |

WARNING TO USERS OF THIS SYSTEM: This is a United States system, tained by the D of the Interior, to provide Official
L i U3 G only. Use ofthis system by any jor user consentto retrieval, and
e by personnel. | use may subject violators to criminal, civil, and for disciplinary action

Notices | Disclaimer | Privacy | FOIA | USA gov | DOI Home | PMB Home

U.S. Department of the Interior
Office of Policy Management and Budget
Last updated: October 22, 2012
Thiz site has basn optimized for Intamet Explorer 7

21

If you clicked on “click here to register” on Login screen, this page will come up. We have
added this step to prevent multiple registrations for the same person. When you enter
your email here the system will check whether you already have an account. If you already
have an account, you will be routed to a page where you can request that your username
or a password be sent to you. If you do not have an account, you will be routed to the
registration page, which is on the following slide.

21



SUSTAINABLE PRACTICES DATABASE

Home ContactUs Help Login

Registration

It's important to
pick a password

Please complete the form below and click the Submit button. If you need help with this registration process, click on B
meetthe following criteria

= Atleast12 characters and no more than 15 characlers
= Contain one upper-case alpha, one lower-case alpha and one numeric character th at fOI |0WS these
= Contain one special character such as @, §, o & 3 ru |es|

USER INFORMATION

Bureau: [SelectaBureau =]
R e 3 Once you pick
et - your bureau and
S o region, you will be
hold Ctel Kay to selact additional facility names. ;I given a Iist Of
First Name: ,— g

facility names to
Last Name: .
Emai oo micrGios dagor pick from here
Phone Number. r
Desired Usemamne: [brien_milchek@iosdoigov
Password: ———————
Verify Password, 1

Submit

22

This is the screen that appears when you submit an email address that does not already
have an account. Enter your information into the form to register for the website. Then
click “Submit”



More on Registration

« User name = your email address

» Central office program manager will be
notified of new facility user registrations.

* You can register to enter data for more
than one facility.

* If you move to a new facility, your central
office program manager can update your
user profile with your new contact and
facility info.

23

Generally, your user name is the same as your email address. You may specify a different
user name during the registration process if you like. Please keep a record of that user
name for future reference.



Site Administration

Change Password

SUSTAINABLE PRACTICES DATABAS

Hoeme Facility Data Reports Bureau ReportGenerator Admin Help Logout

Action Item
pdate Password

Approve Solid Waste
Management Data

Manage User Accounts

Change User Password
Manage Facilities List
Create Email Listing

Listing - Facilities and
Contacts

Manage Regions List

Add Notes

Description
This tool allows user to change their password fo access the system.
This tool allow admin user to approve Solid Waste data of a facility.

This tool allows user to edit or add users to the system. Regional / State program leads should review users
gi in their toensure are the system.

This tool allow user to change password for existing users.
This tool allows user to edit or add facilities to the system.
This tool allows user to create an email listing of all the users in region or bureau

List of contacts associated with facilities

This tool allows user to edit or add regions to the system.

Add notes to assist with preparing this report in the future. Future users from your region/bureau will have access
tothese notes.

Notices | Disclaimer | Privacy | FOIA | USA.gov | DOI Home | PMB Home

U.5. Department of the Interior
Office of Policy Management and Budget
Last updated: October 23, 2012
Thissite has been optimized for Internet Explorer 7

24

If you are able to log into the system, you may change your own password by selecting the

“Admin” tab and then clicking on “Update Password”

24



Change Password

% ! , W - 7 c p ?
e S
Vancy 3, Ol SUSTAINABLE PRACTICES DATABASE
Home Facility Data Reports Bureau ReportGenerator Admin Help Logout

Change Password

To update your password, please enter your new password and then confirm it. Avalid password must meet the following security standards:

= Be atleast12 characters and no more than 15 characters

* Contain one upper-case alpha, one lower-case alpha, and one numeric character.
= Conlain one special character such as @, §, or &

.

The new password cantcontain the old (e.g.the old cantbe'p *and the new password ‘password1).

Password: essssessssssee

Confirm Password: I

25

If you click on “Update Password” this screen will appear. Simply type your new password
into the fields provided. Then click on “Save” and your password will be changed.



Send us an
email

ContactUs Help Login

Department of the Interior FY15 Sustainable Practices Database User Aids

Signed DOI Data Call memo for FY 2015 Reporting on Solid Waste and Chemicals Management
FY 2015 Reporting Training Information Coming Soon
FY 2014 Training Presentations

« Sustainable Practices Database Field User Training (35M8B)
« Sustainable Practices Database Central Office User Training (=583 (3.7 MB)

FY 2012 Training Presentations

+ Sustainable Practices Database Bureau Headquarters User Training (Z5&3 (1.1 MB)

CheCk Out Frequently Asked Questions
the FAQs Feedback Form

Other useful links:

=5 © Trash and Recycling Tracking Tool
Download the Trash and Recycling Tracking Tool using the link above. Do not open the file in Google Sheets as this will cause errors.

| o Guidance on waste-to-energy and waste diversion
New- Tras h » EPA published standard volume to weight conversion factors

and Recycl |ng « Conversion Factors used in this data call
Tracking Tool

26

If you need help, there are many resources available under the “Help” tab. Some of the
resources are highlighted here.

Training presentations will be added to this page as well.

To help you track trash and recycling in FY 2016 and future years, please have a look at the
NEW Trash and Recycling Tracking Tool



Feedback Form

» Use for all your questions and or
comments.

* Your feedback will automatically be sent to
the DOI contacts (OCIO and OEPC) as
well as designated bureau HQ contacts.

Feedback

Please Use This Form To Send Your Questions or Comments.

Name:
Email Address li
27

Questions?

27



DATA ENTRY

» Solid Waste Questions
*Print Report

* Finalize Data

* Central Office Data Review

28
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PREVIEW OF
SOLID WASTE QUESTIONS

29

29



Navigation
Your current

location within the \ TR
system is shown § ; 5
here

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Home » Facility Data » Your facility

SOLID WASTE MANAGEMENT ~ Facility: Other -— name is
Solid Waste Prevention .
Left _ Instructions to enter data shown here
nawgatlon +  Atthis time we are only collecting for Solid Waste t If you have questions, please contact your Bureau

Contacts.

Users can save partially-complete or complete survey data by clicking on the SAVE button atthe bottom of the page before
Your data wil | be lost if you do notclick SAVE atthe botiom of each page.

Click on the 2014 data under "Useful links™ for the reports for FY 2014,

Click on the Bureau Contacts under “Useful links” to see your reviewers.

'When ready, click on any section to enter data

Waste Disposal

.

Toxics and Hazardous
Chemicals Management

Forward Solid Waste Data

Print Solid Waste Data You must Forward Data before your report is complete

i

USEFUL LINKS
Facility Notes

Bureau Contacts

2014 Solid Waste Data

30

Here, the “Facility Data” tab has been selected.

They system has a left-hand side navigation bar, which lists solid waste management
sections of the report.

The user would complete each item under Solid Waste Management to complete the
report.

30



Navigation (cont'd)

SUSTAINABLE PRACTICES DATABASE

ity Data Reports Bureau Report Generator Admin Help Logout

Find the name
and contact

information for "
your designated SOLID WASTE MANAGEMENT ~ Facility: Other

] Solid Waste Prevention :
Central Office and Instructions to enter data
i Recyc!
bureau/office HQ IY—WI + Altthis time we are only collecting information for Solid Waste Management Ifyou have questions, please contact your Bureau
Contatts.
contacts. Waste Disposal « Users can save partially-complete or complete survey data by clicking on te SAVE button at the bottom of the page before

navigating elsewhere.
Toxics and Hazardous « Your data will be lost if you do notclick SAVE atthe bottom of each page.
(G L « Clickonthe 2014 data under "Use ful links™ for the reports for FY 2014,
« Clickonthe Bureau Contacts under "Useful links™ 1o see your reviewers.
Forward Solid Waste Data ’
+ When ready, click on any section to enter data
1 \ Print Solid W
Review the Data [\ aste Dol

you submitted USEFUL Lilwe
last year. You

may print last
year's report and

refer to it when
compiling this

« You must Forward Data before your report is complete.

year's
responses.

31

There is a link to bureau contacts for more information on how to complete this report.

You can click on the link on the lower left to see your facility’s 2013 data. The data have
been locked and cannot be changed.



Enter notes
here for next
year’s report

and view
notes added
in previous

years

Facility Notes

¥ SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout

4
SAcH 3.

Home =» Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT
Solid Waste Prevention

Recycling
Waste Disposal

Toxics and Hazardous
Chemicals Management

Fonward Solid Waste Data

Print Solid Waste Data
USEFUL LINKS

Bureau Contacts
2014 Solid Waste Data

Facility: Other

Facility Notes

Add Notes:

Add notes to assist with preparing this reportin the future. Future users from your facility will have access to these notes.

Existing Notes for this Facility:
* 1234 (06/08/13)

32
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Solid Waste Prevention

eSS SUSTAINABLE PRACTICES DATABASE

Home acility Data Reports Bureau Report Generator Admin Help

Z
m
%
- f
1Y |
@
[}
E
s

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT ~ Facility: Other

Solid Waste Prevention . .
v A. Solid Waste Prevention

Recycling Note: You must click on “SAVE" below or your data will be lost.

Waste Disposal 1) Isyour facility in leased space?

Toxics and Hazardous ¢ Yes No

Chemicals Management .
1a) s your facility in leased space within a multi-tenant building?

Forward Solid Waste Data Yes * No

Print Solid Waste Data 2)  Does your facility have an active office products recycling program?

USEFUL LINKS * Yes No
Facility Notes 3)  Does your facility have housing units?
.
Bureau Contacts Yes Ne

3a) Ifapplicable, how many residential housing units operated by your facility have access to an active
2014 Solid Waste Data household products recycling program?

units of total units
The dstabase wi Calculste the perSen tage BaSed on the NUMBET of Un LS yOu PrOVIEs here

33

Click on Solid Waste Prevention to begin data entry.

This screen will appear

The questions shown here are pretty straight-forward, just indicated whether your facility
(1) is in leased space, (2) has a recycling program, (3) has housing units.



Solid Waste Prevention (cont'd)

Did your facility institute new, substantially improved, or updated non-hazardous solid waste 7)  Within FY 2012 contracts for your facility, did any specifications include a requirement for Waste

InFy 20127 For on solid waste pr Please go to Reduction Plans (FAR Clause 52.223-10) in demolition, construction, and service contracts to achieve
tp: /w20, GOVIR eQIon T/waste/soliwaste/reduce_waste him T SR gtom., et sp!m)c i 5

&

o] c
Yes Ne C ves © No © NetApplicable

‘What is your facility's goal for solid waste diversion by 20157
DOFE Wasts Divamion goal is S0% by 2018,

If yes, explain (255 characters max):

5)  Does your facilty compost any of its waste (either onsite or offsite)? 8

© Yes © Ne

Er— Please input enly numbers.

omg g taciny, slect ot ompostng” Wyou
TPCAR TAEIY, Sl O ampoting v 9) Do you have onsite waste disposal, such as a landfill, at your facility? Please answer “yes" if your

facility has a permitted Ianatill that was in operation amytime between 1980 and today.

It yes, selectthe type of composting

C ves © No

63) It yes, how many demoltion projects managed by andor conducted at your facilty include the racorery R

of construction materials?

emaition projects of total demoiition projects in FY 2012
e

Notices | Disclaimer | Privacy | F DOl Home | PMB Home

Within FY 2012 contracts for your facility, did any specifications include a requirement for Waste
Reduction Plans (FAR Clause 52 223-10) IN demolifion, conNStruction, and service cONracts o achieve
waste diversion goals? Provide specific examples

© ves © Ne © NotApplicable

Save partially-complete or complete
survey data by clicking on the “SAVE”
button at the bottom of each page
before navigating elsewhere.

If you do not click on “SAVE” your
data will be lost!

34

Note that there are links to hints and helpful information for answering the questions, such
as links to “non-hazardous solid waste prevention practices” and “recovery of construction
materials”

Note that for question #5, the question on composting, re-use of materials onsite such as
mulch or grasscycling in landscaping is not composting. To count as composting, material
must be decomposed in some manner before it is re-applied to landscaping.

For question #9, we are asking whether you have an onsite landfill.

When you are done entering data on this page, click “SAVE” — THIS IS CRITICAL, YOUR DATA
WILL NOT BE SAVED UNTIL YOU CLICK THE “SAVE” BUTTON

34



Recycling

Home Facility Data Repol

Bureau Report Generator Admin Help Logout
Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT ~ Facility: Other
Solid Waste Prevention

B. Recycling
) iz ) Note: You must click on “SAVE" below or your data wil be lost.
Waste Disposal 1) Indicate which of these commodities your facility recycled during FY 2015 (10/1/14 - 9/30/15). Waste

for energy may not be counted as recycled.
Guidance on waste-to-energy and waste diversion

Toxics and Hazardous
Chemicals Management

il

Aluminum Keyboard
Forward Solid Waste Data @ Antifreeze Light Ballasts
Print Solid Waste Data Asphalt # Manure
USEFUL LINKS Batteries (Lead/ackd - car) Mixed Paper
Batteries (Lead/acid - truck) Monitor
tteries (NICd rechargeabl New r
(e Batteries (NIiCd rechargeable) lewspape!
Batteries - Mixed Notebook PC
2014 Solid Waste Data
Brick Pallets
Car Tires Plastic (#1PET/#2HDPE)
Cardboard Printer
Carpet Scrap Metals
Co-mingled ) Ceiling tiles single-Stream Mixed Recyclables (steel and
. aluminum cans, glass and plastic bottles, mixed
category includes Co-mingled (glass, Al cans, plastic) paper. cardboard)
most cont: Concrete Steel Cans

Single
Stream
Category

includes
containers
and paper

Under “Recycling” click on the commodities that your facility recycled during FY 2014.

Then click “SAVE”.

35



B. Recycling

Recycling (cont'd)

+ Conversion Factors used in this data call.

Note: You must click on € SAVE® below or your data will be lost.

Please input the actual or estimated weight or volume of the total amount of each commadity recycled during FY 2013 from your
facility. There are volume to weight conversions programmed into the system for most commodities.

+ EPA published standard volume to weight conversion factors.

« Ton = 2,000 pounds

Select Recycled C&D Waste only for items recycled as the result of construction and demolition projects.

* C&D waste = construction and demolition waste.

+ Metric Ton = 1,000 kilograms = approximately 2,205 pounds

You must enter amount and select Type of Recycling for each commodity.

‘Commodity Amount Recycled Unit CompactedMNot Type of Recycling

Otver lbs [compacted =] |[Select

Aluminum Io ‘Ibs j | F Jj P d
Recycled C&D Waste

Cardboard o [1bs | |uncompacted | Other Recycling

Mixed Paper |o ‘Ibs j |unoompucled :] IOther Recycling j

SAVE

onversion
factors used
are
available
through

Select the Type
of Recycling
here to avoid
receiving an
error later on

For each commodity that you selected on the previous page, you will be asked to enter the
amount recycled. You may enter the amounts in a variety of units, as shown here, but they

will be automatically converted to tons for the final report.

You must enter the amount recycled, there are some options for units you can use such as
tons, pounds, cubic yards, etc.

Under “type of recycling” you must enter whether the recycled waste is recycled

construction and demolition waste (C&D waste), composted, or other recycling. Other

recycling is generally recycled municipal solid waste.

Click “SAVE” when you’ve entered all of your data for the commodities recycled.

36



Recycling Data Tips

* Check your units — 100 tons of paper = 200,000
pounds of paper, which is a lot of paper.

» Check estimates of amounts recycled — If a
facility reports 200,000 cys paper recycled, this is
equivalent to 75,000,000 pounds. Please do not
over estimate.

+ Be careful with decimals and zeros - extra zeros

can greatly increase your recycling amounts.

37
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Recycling (cont’d)

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT

Solid Waste Prevention

Recycling

Waste Disposal

Toxics and Hazardous
Chemicals Management

Facility: Other

B. Commodities Recycling

For FY 2015, your facility recycled:
100 Ibs of Uncompacted Antifreeze - Other Recycling = 100 Ibs

50 Ibs of Uncompacted Ceiling tiles - Recycled C&D Waste = 50 Ibs
100 Ibs of Uncompacted Concrete - Recycled C&D Waste = 100 Ibs

50 Ibs of Uncompacted Manure - Composted = 50 Ibs

25 Ibs of Uncompacted Pallets - Recycled C&D Waste = 25 Ibs
Total: 325 Ibs = 0.163 tons
Total C: g: 50 1bs = 0.025 tons
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Total C&D Recycling: 175 os = 0.068 tons
Total Other Recycling: 100 Ibs = 0.050 tons

The Recycling data has been saved for this facility

Please proceed to Solid Waste Management Waste Disposal

4

After you’ve entered information for your commodities recycled, you will see a summary of
the data you entered for those commodities.

After reviewing the data, click on the link to proceed to the “Waste Disposal” section of the
report.



Waste Disposal

E  Bureau Report Generator Admin Help Logout

igement s

AllOther Trash (Municipal Solid Waste) sent to Waste-to-E nergy 100000 Ibs (
Facility: Other . Tow
cyeied

C. Waste Disposal

Note: You must click on “SAVE" below or your data will be lost.

Please input only numbers. ¥ ou can input 0 if you do not have any of these types of waste.

Type of Waste Amount | unit

Construction and Demolition Waste Sent to Landfill or Waste-to-Energy 100000 Ibs
(C&D Waste)

= Total amount of construction & demelition waste sent for disposal in FY
14

aebris tat restoration projects.

All Othe  Trash (Municipal Solid Waste) sent to Landfill 100000 Ibs

. Total amour

You must enter data on this screen or
LD you will receive an error message.
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In the Waste Disposal section you will be asked about the total amount of waste disposed
and not recycled.

Do not include any amounts recycled on this page.

Report amounts for:

- Construction and demolition waste not recycled

- Municipal solid waste sent to the landfill and not recycled
- Waste sent to waste-to-energy facilities

Click on “Need help estimating waste amount?” if you need assistance.

Also please note that any waste burned for energy is not considered to be diverted waste.
You may still report the amount burned for energy here. Please see the linked Guidance on
Waste-to-Energy Data.
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SUSTAINABLE PRACTICES DATABASE

cility Data  Reports  Bureau Report Generator Admin  Help Logout

Home » Facility Data » Solid Waste Management s

SOLID WASTE MANAGEMENT Facility: Other

Solid Waste Prevention .
C. Waste Disposal
Recycing The Waste Disposal data has been added for this facilty.
Waste Disposal Category Undiverted Waste (tons) Recycled (tons) Diversion rate
Construction & Demolition 50 0.088 0.17%
Toxics and F !
Chemicals Management Municipal 100 0.075 0.07%
Forward Solid Waste Data Total 150 0.163 0.11%
*The formula for calculating waste diversion is:
Print Solid Waste Data Recycled materials

USEFUL LINKS Recycled materials + Trash

Facility Notes
Gas
Bureau Contacts
Your undiverted municipal solid waste has resulted in approximately 73.02 MT C O2e (metric tonne carbon dioxide equivalent)
in

gas emissions.

2014 Solid Waste Data

Gas Emissions amount = shorttons of undiverted municipal waste x 0.7302 MTCO2e/short ton

Department Waste Diversion Goal: 50% or more by FY 2015.
Your facility has yet not reached this goal.

Access to recycling services and facilities differs in different parts of the country. Please consider implementing additional cost-
effective measures to further prevent the generation of solid waste and to recycle atyour facility.

Guidance on how to enhance your Waste Diversion and Recycling Program.

State Waste Diversion Goal: The diversion goal for state is NIA.

oxics and Hazardous Chemicals Management

Please proceed to Solid Waste Management

Once you have entered and saved all of your data for Recycling, you will see this screen.
Note that there are additional links providing information on how to enhance your waste
diversion and recycling program and about recycling goals. Click on the link at the bottom
to “Proceed to Solid Waste Management: Toxics and Hazardous Chemicals Management.”
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Data Entry Guidelines

Facilities must provide data for undiverted waste in addition to what was
recycled for both municipal solid waste and construction and demolition
(C&D waste).

Undiverted waste is the amount that went to the landfill and/or waste-to-
energy (WTE) facilities.

Facilities reporting only amounts recycled and a 100% recycling rate
will be asked to explain why they have such a high recycling rate.

Report amounts of biomass/wood chips burned onsite for heat or
electricity as WTE if wood would have otherwise gone to a landfill

Even if waste disposal is free, the amount disposed of should be
reported.

Please do not double count. If a quantity of a commodity is reported as
recycled, that quantity should not be included in the landfill or waste-to-
energy amounts.

41
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Toxics And Hazardous

SUSTAINABLE PRACTICES DATABASE

Reports Bureau Report Generator Admin Help Logt

Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT ~ Facility: Other

Sokd Waste Frevention Toxics And Hazardous Chemicals Management

Recycling Note: Youmust click on “SAVE" below or your data will be lost.

Waste Disposal 1) Briefly describe what your facility has done to reduce the purchase of toxic and hazardous chemicals
Do not report quantitative information (volume or dollars) on chemicals or chemical-containing

roducts purchased or reduced.
Toxics and Hazardous P P

Chemicals Management
We have implemented a plan to replace mercury with non-mercury

Forward Solid Waste Data

Print Solid Waste Data

USEFUL LINKS

Facility Notes
Bureau Contacts

2014 Solid Waste Data
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This is the page to enter information on your facility’s efforts to reduce the purchase, use
and disposal of toxic and hazardous chemicals. Enter your narrative information and click
“SAVE.



PRINT REPORT
FORWARD DATA
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Printing your reports

* Print a copy of each report before you
finalize!

— Hard copy can be circulated for review and
approval within your facility prior to finalizing
— Click on “Print Solid Waste Data”

— Navigate to web browser and select print
function there

44
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Printing your reports

SUSTAINABLE PRACTICES DATABASE

Home FacilityData Reports Bureau Report Generator Admin  Help Logout

Home » Facility Data » Solid Waste Management »

Facility: Other
SOLID WASTE MANAGEMENT

Solid Waste Prevention Summary: Solid Waste Management [
Click on the PRINT button to printthe report
Solid Waste Prevention
Toxics and Hazardous
When you are Chemicals Management
done enterlng Forward Solid Waste Data

data, you may
print your USEFUL LINKS

report here.

>

1)  Is your facility in leased space?

1a) Is your facility in leased space within a multi-tenant building?

2)  Does your facility have an active office products recycling program?

3) Does your facility have housing units?

3a

It applicable, how many residential housing units operated by your facility have access to an active
household products recycling program?

of total units

abase wl caiculate the percentage based on the number of uns you provide here

units

4)  Did your facility institute new, substantially improved, or updated non-hazardous solid waste prevention
practices in FY 20157

If Yes, please explain (256 characters max):

5) Does your facility compost any of its waste (either onsite or offsite)?

45

If yes, select the type of composting.
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Forward Data

SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Home » Facility Data » Solid Waste Management »

Facility: Other

Somd lion Forward Solid Waste Management Data

Recycling
C||Ck here fol" - After you click on "Continue” your regional or central office will be notified that your facility data are
Waste Disposal available for review.
y0ur report tO = After your data have been reviewed at the regional or central office level, your data will be
Toxics and Hazardous forwarded to your bureau headquarters for review and inclusion in your bureau's Sustainable
be forwarded Chemicals Management Practices Report

Forward Solid Waste Data

to the
regional,

State or area USEFUL LINKS # Forward the Solid Waste facility data for approval.

Sl

Bureau Contacts

If all the data for Solid Waste has been added / edited completely, check the box to forward the facility data
for regional approval

p
o
=
o
5
i
:
Q
2
B
g

Print Solid Waste Data

office

2014 Solid Waste Data

46

When you have completed entering the data for Solid Waste Management or Green
Purchasing, you must “Forward Solid Waste Data” before it is sent to the Central Office for
approval.



System Checks

Facility: District Office

Forward Solid Waste Management Data

Your data is complete but

The total recycled amount for your facility is at least 10 times greater than the FY 2011 recycled amount
The total trash amount for your facility is atleast 10 times greater than the FY 2011 trash amount.

The total recycled amount for your facility is at least 1000 tons more than FY 2011 recycled amount

Please verify the data you've entered and/or provide an explanation here
Please select reason’s:

I Facility Expanded Recycling/Composting

I™ Facility Started New Recycling/Composting

I Facility had a singular event that increased/decreased quantities
I Disposal increaseidecrease was due to changes in Visitation
™ Usage or Temporary Facility Closure

W Improved Tracking

I™ weighing Trash instead of Volume Estimates

I~ Added New Materials to Recycling Program

Please explain:

More accurate tracking

+ The system checks for data completeness and
consistency when you click on “Forward Solid
Waste Data”

« Errors like the one shown here appear when:

* Recycling is 10 times or greater than last
year’'s amount

*Recycling is less than 10% of last year’'s
amount

*Greater than 50 ton variation in trash or
recycled amount if total waste is 100 tons or
less.

» Non-diverted waste is 10 times or greater
than last year’s amount

» Non-diverted waste is 10% or less of last
year’s amount

*Greater than 1,000 ton variation in trash or
recycled amount

* Recycling rate is 100%
= You must either correct your data or provide an
explanation when you receive this error.
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System Checks

» These errors show

\agement »
that we have not
Facility: OEPC Albuquerque Regional Office entered a" Of the
Forward Solid Waste Management Data ] required data_
Your data on Solid Waste Management Data is not complete yet. Please enter all the data and then finalize
it. Please complete the following data . We must

The data on the Recycling Program / Solid Waste Prevention is not complete.
« Explanation on new, substantially improved, or updated solid waste prevention practices (Solid Com plete these
Waste Prevention #4).
« Explanation on Requirement for Waste Reduction Plans.(Solid Waste Prevention #7) entries pr|0r -to
forwarding our

data.
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If your data are not complete when they are finalized, a screen will appear to tell you what
information is missing and must be completed before it can be finalized. You must enter
this data before it can be submitted to your Central Office.
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Forward Data

s Bureau Report Generator Admin Help Logout

ragement »

Facility: OEPC Albuquerque Regional Office

Forward Solid Waste Management Data

o Afteryou click on "Continue® your regional or central office will be notified that your facility data are available for review.
* Afteryour data have been reviewed at the regional or central office level, your data will be forwarded to your bureau
headquarters for review and inclusion in your bureau's Sustainable Practices Report
If all the data for Solid Waste has been added / edited completely, check the box to forward the facility data
for regional approval

) ™ Forward the Solid Waste facility data for approval.

CONTINUE
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If you have completed all of the information required by the Sustainable Practices
Database, you will see this screen when you click on “Finalize Data”. Click on the box to
forward your data, and then click on “Continue” for your data to be forwarded to the
Central Office for approval. Your Central Office manager will receive an email notifying
them that your report has been finalized.

Once you have finalized your data, the facility user will not be able to edit it. If you discover
an error, contact your Central Office to return the data to you so that you can make the
change. If data is returned and sent back to you, you must finalize the report after you
make your changes so that the Central Office will be notified you have made your changes.

You will receive an email if your Central Office returns your report to you for changes.
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Provide Feedback

After the facility data are successfully forwarded, the user will see a
new screen to provide suggestions to improve the reporting system

Please enter comments in the box provided and click “Save”

s SUSTAINABLE PRACTICES DATABASE

Home Facility Data Reports Bureau Report Generator Admin Help Logout
Home » Facility Data » Solid Waste Management »

SOLID WASTE MANAGEMENT ~ Facility: Other

Solid Waste Prevention .
|:| Forward Solid Waste Management Data
Recycling Solid Waste Regional Manager -
« kathleen_chiang@ios.doi.gov
+ daniel_faudonis@ios.doi gov
Waste Disposal
The facility Solid Waste data has been forwarded successtully
Toxics and Hazardous Thank you for completing your report. f you would like tools ta help rack your waste to complete the next report, please visit the H
Chemicals Management page at hitps Jiwww.nbe gov/spreportuseraids.himl
Wi i I i Vi .
Forward Solid Waste Data Please provide any additional sugg or forimproving the report.
Print Solid Waste Data

USEFUL LINKS

Facility Notes
Bureau Contacts
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This screen will appear after you have successfully forwarded your facility’s data.
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Central Office Data Review

At this stage:

- If edits or clarification are I—— Facility User enters data

necessary the Central _\l‘/ﬁ

Office program reviewer - % .
sends report back to r Facility User finalizes data and forwards it for review

K. 28

Facility User.

- Then the Facility User
makes changes and re-
finalizes the data, sending
the report back to the
Central Office.

-If no changes are needed,
the Central Office User can
forward data to the Bureau
HQ User

51

Once the Central office receives the data, the Central Office may decide that there is a
problem with the facility data that must be corrected before it can be forwarded on to the
bureau or office HQ level for approval. If there is a problem with facility data, the Central
Office User may send the data back to the facility user for correction by “Unapproving” or
“Returning” it.

If the Central Office sees that the data for its facilities are ready to be forwarded on to the
Bureau HQ level, the Central User may then forward the data on. For more information on
this process, please see the Powerpoint presentation for Central Office Users.
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Historical Reports

Home Facility Data Reports Bureau Report Generator Admin Help Logout

Solid Waste Reports - Historical Bureau Data

Reportonly includes data for active facilities. Previous years' data for facilities that are currently deactivated are notincluded
Allamounts are in tons.
Click on the bureau name to see the data for the regions

Download historical data in EXCEL

2014 2013 2012

Recycled (tons) Waste (tons) Waste Diversion  Recycled (tons) Waste (tons) Waste Diversion Recycled (tons) Waste (tons) Waste Diversion
Total 0.00 0.00 0.00% 10,361.75 1,364.86 88.36% 226,069.07 94,172.02 70.59%
os 0.00 0.00 0.00% 1021 1,110.93 0.91% 157 0.00 100.00%
NPS 0.00 0.00 0.00% 10,000.00 0.00 100.00% 59,364.81 63.27%
FWS 0.00 0.00 0.00% 96.88 29.81 76.47% 24,517.48 47.39%
USGS 0.00 0.00 0.00% 0.00 0.00 0.00% 1,793.10 937.54 65.67%
BOEM/BSEE 0.00 0.00 0.00% 0.00 0.00 0.00% 4387 67.41 39.42%
OSMRE 0.00 0.00 0.00% 0.00 0.00 0.00% 40.06 38.76 50.82%
BIA 0.00 0.00 0.00% 0.00 0.00 0.00% 0.14 0.00 100.00%
BLM 0.00 0.00 0.00% 0.00 0.00 0.00% 25,999.04 4,261.36 85.92%
BOR 0.00 0.00 0.00% 5.54 5.00 4,713.88 93.98%
OFAS 0.00 0.00 0.00% 249.12 21911 270.79 53.41%
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Within the “Reports” tab, there are reports with historical data available. This report
compares solid waste data for the last three years.

To drill down within the bureau, just click on the Bureau name, and on the following screen
click on the Region name. You will then be able to see the facility historical data.

III

If you “Download historical data in Exce
available.

you will see data for all years that data are
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Historical Reports

SUSTAINABLE PRACTICES DATABASE

Facility Data Reports Bureau Report Generator Admin Help Logout

2010 Reports

Click on the Solid Waste reportto print a copy of solid waste repon for that facility.
Facility (Region) SolidWaste
Office of the Secretary
HOQ
District Office Solid Waste Report
OEPC Albuguerque Regional Office Solid Waste Report
OEPC Anchorage Regional Office Solid Waste Report
OEPC Atlanta Regional Office Solid Waste Report
OEPC Boston Regional Office Solid Waste Report
OEPC Denver Regional Office Solid Waste Report
OEPC Headquarters Solid Waste Report
OEPC Oakland Solid Waste Report
QEPC Philadelphia Solid waste Report
OEPC Portiand Solid Waste Report
Other Solid Waste Report
Program Office Solid Waste Report
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You can also download complete reports for each facility for FYs 2006 - 2014.
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Questions can be emailed to SPReport@ios.doi.gov

Thank you for your time and attention!

QUESTIONS? WRAP-UP
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